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Úvod

V tomto tisícročí sme sa ocitli vo svete plnom nových technológií, počítačov, Internetu, mobilov... V súčasnosti sú bežnými užívateľmi počítačov aj naprostí laici, deti, predavačky, zdravotné sestry, pracovníci v bankách, podnikatelia atď. Počítače sa stali ozajstnými pomocníkmi nielen na väčšine pracovísk, v domácnostiach, ale aj vo vyučovaní.


Počítače a Internet možno efektívne uplatniť vo všetkých fázach vyučovacieho procesu, pri motivácii, pri opakovaní, pri osvojovaní nového učiva, pri upevňovaní a prehlbovaní, pri preverovaní aj hodnotení žiakov, pri ich domácej príprave, ako aj pri spätnej väzbe.
Výhody používania počítačov a Internetu vo vyučovaní sú najmä:

· individualizácia vyučovania, 

· motivácia žiakov, 

· objektívnosť hodnotenia žiakov, 

· okamžitá spätná väzba, 

· možnosť rýchlo a efektívne komunikovať, 

· efektívnosť získavania informácií, 

· veľké zobrazovacie možnosti, 

· automatizácia pracných výpočtov, eliminácia rutinných prác, úspora času. 

Využitie výpočtovej techniky a hlavne možností Internetu je veľkým prínosom pre vyučovanie vôbec a teda aj pre vyučovanie matematiky. PC a Internet na hodinách nie je len novou učebnou pomôckou, ale dáva vzdelávaciemu procesu nový, širší rozmer.

V tejto práci uvádzame svoje skúsenosti s využitím Internetu pri vyučovaní jedného konkrétneho tematického celku v gymnaziálnej matematike – diferenciálneho počtu. Uvedené aktivity boli zrealizované v marci a apríli 2006 v septime B (trieda s rozšíreným vyučovaním matematiky) Gymnázia na Alejovej ulici č.1 v Košiciach. Budeme radi, ak táto práca konkrétnymi ukážkami a námetmi inšpiruje aj ďalších učiteľov matematiky k tomu, aby siahli po Internete aj na vyučovacích hodinách.
Využitie Internetu pri vyučovaní diferenciálneho počtu
Diferenciálny a integrálny počet (často aj infinitezimálny počet) je jedna z centrálnych disciplín matematiky, ktorá v súčasnosti tvorí základ matematickej analýzy. Diferenciálny počet študuje rýchlosť zmeny, ktorá je zvyčajne vyjadrená smernicou krivky. Je založený na probléme hľadanie okamžitej rýchlosti zmeny jednej veličiny vzhľadom na inú. Typickým príkladom problémov diferenciálneho počtu z reálneho sveta je hľadanie nasledovných veličín: 
· zrýchlenie a rýchlosť voľne padajúceho telesa v danom okamihu, 

· strata rýchlosti a trajektórie vystreleného projektilu, napr. delovej gule či guľky
z pištole, 

· zmena v ziskovosti rastúceho podniku v určitom okamihu času. 

Vývoj a použitie diferenciálneho a integrálneho počtu malo a má ďalekosiahle dôsledky na skoro všetky aspekty moderného bytia. Je prítomný takmer vo všetkých vedách, hlavne vo fyzike. Prakticky všetky moderné výdobytky, ako stavebné techniky, letectvo a iné technológie používajú infinitezimálny počet priamo vo svojich základoch. Veľa algebraických vzorcov, ktoré sú dnes používané v balistike, energetike a iných praktických vedách, boli odvodené prostredníctvom diferenciálneho a integrálneho počtu.
Počas stredoškolského štúdia sa žiaci oboznamujú so základmi infinitezimálneho počtu, pričom skúsenosti hovoria o tom, že ide o najťažšiu časť stredoškolskej matematiky. Aj preto považujeme za dôležité hľadať možnosti, ako túto tému žiakom lepšie priblížiť. Z tohto dôvodu sme sa rozhodli zistiť, čím nám v tomto smere môže pomôcť Internet.

Základným pomocníkom pre využitie počítačov pri štúdiu matematickej analýzy je pre nás dobrý kreslič funkcií. Programy, ktoré kreslia grafy funkcií, nie je na Internete ťažké nájsť. Dajú sa veľmi výhodne využiť na hodinách pri preberaní učiva o funkciách, poslúžia šikovne na demonštráciu grafického riešenia rovníc a nerovníc rôzneho typu, vedia vykresliť nielen graf funkcie, ale aj geometrického útvaru daného analytickým vyjadrením, dá sa pomocou nich vykresliť aj derivácia danej funkcie, viesť dotyčnica daným bodom, vykresliť aj vyčísliť určitý integrál. Umožňujú zväčšovať a zmenšovať, nakresliť v krátkom čase do jedného obrázku celú sériu grafov funkcií líšiacich sa len hodnotou nejakého parametra. Tým žiak môže sám, vlastnou rukou získať predstavu o význame daného parametra pre tvar, alebo polohu grafu funkcie. Jeho predstava o grafoch funkcií a teda i o pojme funkcia sa stane bohatšou a v prípade, že k poznatku došiel vlastnou manipuláciou s počítačom tak aj trvalejšou. Nám sa veľmi osvedčil program Graphmatica pre jeho jednoduché ovládanie. Keďže je voľne stiahnuteľný z Internetu, žiaci si ho môžu nainštalovať aj doma a využívať v príprave na vyučovanie.
Ďalej sme využili aj niekoľko apletov k danej téme. Aplety sú interaktívne javovské programy, animácia je dosiahnutá najčastejšie možnosťou pohybu nejakého bodu, resp. väčšieho útvaru. Na väčšine stránok sa nachádza sprievodný text, matematický teoretický základ, vzorce, odvodenia, návodné úlohy, otázky a pod. Okrem toho sme použili aj testy a niekoľko zaujímavých stránok. 
Na nasledujúcich stranách popisujeme  šesť aktivít, realizovaných v rámci tohto tematického celku s využitím Internetu. Pritom na vyučovacích hodinách bolo možné podľa potreby buď ísť so žiakmi do učebne informatiky alebo pracovať v triede s nootebookom a dataprojektorom.
1. Úvod do štúdia diferenciálneho počtu

Metódy: frontálny výklad

Použité zdroje:   
[1]- http://sk.wikipedia.org/wiki/Diferenci%C3%A1lny_a_integr%C3%A1lny_po%C4%8Det
[2] - http://sk.wikipedia.org/wiki/Obr%C3%A1zok:Newton.jpg
[3] - http://sk.wikipedia.org/wiki/Obr%C3%A1zok:Leibniz.jpg
[4] - http://www.ies.co.jp/math/java/calc/doukan/doukan.html
Popis: Na úvod nového tematického celku sme si pripravili historické poznámky podľa článku „Diferenciálny a integrálny počet“ [1]. Keďže najväčšiu zásluhu na rozvoji tejto časti matematiky mali  Isaac Newton a Gottfried Wilhelm Leibniz, pripravili sme si aj ich portréty ([2] a [3]) s poznámkami o ich živote a diele.
Nasledovala geometrická interpretácia derivácie funkcie v bode ako smernice dotyčnice ku grafu funkcie v danom bode. Na podporu tejto geometrickej predstavy sme použili aplet so surfujúcim panáčikom [4]. Tento aplet je nádherný svojim dôvtipom, predstavuje deriváciu ako surfovanie po vlnách. Mód s panáčikom sa dá vypnúť, tak isto aj vykresľovanie derivácie. Na začiatku je vhodné so žiakmi ozrejmiť, prečo má dolná odvesna veľkosť 1, kde sa vykresľuje hodnota derivácie v bode a prečo môžeme chápať deriváciu ako novú funkciu.

                 [image: image1.jpg]Drag the red point





2. Derivácie elementárnych funkcií

Metódy: samostatná práca žiakov na PC

Použité zdroje: 
[5] - http://www8.pair.com/ksoft/
Popis: Po oboznámení sa s pravidlami pre derivovanie súčtu, súčinu a podielu funkcií, vzťahmi pre derivovanie elementárnych funkcií a zložených funkcií nasleduje „drilovanie“ – žiaci potrebujú získať zručnosť v derivovaní funkcií. Chýba tu však spätná väzba – pri riešení napr. rovnice môžeme urobiť skúšku správnosti dosadením. Ako však overiť, že sme funkciu správne zderivovali? Tu môže veľmi dobre poslúžiť kreslič funkcií, ktorý dokáže zostrojiť aj deriváciu funkcie. Na hodinách matematiky sa nám veľmi osvedčil program Graphmatica [5], žiaci prácu v tomto prostredí ovládajú z nižších ročníkov. 

Úlohou žiakov pri tejto aktivite bolo najprv do zošita vypočítať derivácie niekoľkých funkcií, napr.: 
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Potom si svoje riešenia skontrolovali v Graphmatice nasledovným postupom:
1. spustiť program Graphmatica

2. do príkazového riadku zapísať rovnicu funkcie, po stlačení klávesy Enter sa zobrazí graf príslušnej funkcie (v prípade problémov so správnymi zápismi možno vyvolať pomocníka príkazmi Help → Operator table alebo klávesou F1; v prípade potreby môžeme graf upravovať pomocou príkazov View → Graph paper, View → Colour, View → Grid range)
3. zostrojiť graf derivácie funkcie kliknutím na ikonku 
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 – graf sa objaví v tom istom obrázku
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4. po kliknutí na graf derivácie funkcie sa v príkazovom riadku objaví rovnica derivácie, ktorú porovnáme s tou v zošite

5. opakovaním 3. a 4. kroku môžeme nájsť aj vyššie derivácie danej funkcie (žiaci pracovali s funkciou 
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Aktivita prebehla veľmi dobre, ukázalo sa, že iba dvaja žiaci  robili chyby pri derivovaní.


[image: image8.wmf]
3. Vety o strednej hodnote
Metódy: problémová metóda – samostatná práca žiakov na PC; frontálny výklad

Použité zdroje:
[5] - http://www8.pair.com/ksoft/
[6] - http://www.ies.co.jp/math/java/calc/rolhei/rolhei.html
[7] - http://www.infovek.sk/predmety/matem/hlav/rolleveta.html
Popis: Vyučovacia hodina prebehla v nasledovných fázach:
a) Žiaci pracujúci samostatne v programe Graphmatica [5] dostali nasledovné zadanie: 
Zostrojte graf ľubovoľnej nemonotónnej funkcie. Zostrojte jej deriváciu. Zistite, či viete nájsť taký interval 
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b. f má deriváciu na 
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Ak ste našli taký interval, pokračujte. Ak nie, zvoľte novú funkciu (. Teraz zistite, či 
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. Do zošita si zapíšte vašu funkciu, hodnoty a, b, c a načrtnite si jej graf aj s hodnotami a, b, c.

Táto úloha bola pre žiakov problémová, museli samostatne analyzovať zadaný text a nájsť funkciu daných vlastností. Keďže sa s vetou o strednej hodnote ešte nestretli, nevedeli dopredu, k akému záveru majú dôjsť.
b) Nasledovala diskusia – okrem troch žiakov, ktorí úlohu nepochopili, všetci ostatní našli funkciu spĺňajúcu dané podmienky. Okrem bežných elementárnych funkcií, napr. 
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 sa objavili aj zložitejšie funkcie, napr. 
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. Niekoľko grafov bolo načrtnutých na tabuľu aj s vyznačenými hodnotami a, b, c. Spoločne sme sformulovali hypotézu, že daná veta platí vždy.
c) V ďalšej časti bola táto Rollova veta presne sformulovaná a nadiktovaná, za ňou nasledovala Lagrangeova veta spolu s niekoľkými príkladmi. Na podporu súvisu medzi Rollovou a Lagrangeovou vetou bol použitý aplet [6], kde pekne vidno 
geometrickú interpretáciu oboch viet - súvislosť s dotyčnicami ku grafom funkcií.
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d) Na záver bola ako zaujímavosť žiakom prednesená  Balada o vete Rollovej [7]. Takéto spestrenie vyučovacej hodiny žiaci uvítali, dokonca sa vyskytla otázka, či môžu aj pri ústnej odpovedi povedať znenie vety vo veršoch...
4. Monotónnosť a derivácia
Metódy: problémová metóda - samostatná práca žiakov na PC; frontálny výklad 
Použité zdroje: 
[5] – http://www8.pair.com/ksoft/
[8] -  http://www.univie.ac.at/future.media/moe/galerie/diff1/diff1.html#ableitung
Popis: Po zvládnutí techniky derivovania nastáva čas na oboznámenie sa s možnosťami využitia derivácií v matematike. Prvou takouto aplikáciou je určovanie intervalov monotónnosti funkcie za pomoci prvej derivácie. Pritom by bola škoda nevyužiť možnosti, ktoré poskytuje kreslič funkcií práve v tom, že dokáže v jednom obrázku vykresliť graf funkcie aj jej derivácie. 


Žiaci pracujúci samostatne na PC dostali nasledovné zadanie:

Skupina A – Po jednom si postupne zostrojte v Graphmatice grafy nasledujúcich funkcií aj s ich deriváciami:   
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. Pri každej funkcii rozhodnite, či platia nasledovné hypotézy:
1. Ak 
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 pre všetky x z nejakého intervalu, tak f rastie na tomto intervale.

2. Ak f rastie na intervale I, tak pre všetky 
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Skupina B – Po jednom si postupne zostrojte v Graphmatice grafy nasledujúcich funkcií aj s ich deriváciami:   
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. Pri každej funkcii rozhodnite, či platia nasledovné hypotézy:
1. Ak 
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 pre všetky x z nejakého intervalu, tak f klesá na tomto intervale.

2. Ak f klesá na intervale I, tak pre všetky 
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Nasledovala diskusia o získaných výsledkoch a formulácia príslušných viet. Na podporu predstavy o vzťahu derivácie a monotónnosti sme použili aplet [8], kde možno pozorovať zmenu znamienka derivácie v súvislosti s monotónnosťou funkcie.
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5. Lokálne extrémy a derivácia
Metódy: problémová metóda – skupinová žiakov na PC; frontálny výklad

Použité zdroje: 
[5] - http://www8.pair.com/ksoft/
[9] - http://www.ies.co.jp/math/java/calc/x_2nd/x_2nd.html
[10] - http://www.ies.co.jp/math/java/calc/sin_2nd/sin_2nd.html 
Popis: Ďalšou oblasťou využitia derivácií v matematike je hľadanie lokálnych extrémov funkcií. Pri tejto aktivite sme sa snažili o to, aby žiaci sami našli požadované súvislosti. Pracovali v malých skupinkách (2 - 3 žiaci pri počítači) s apletmi [9] a [10], v ktorých sú pod sebou vykreslené graf funkcie, jej prvá aj druhá derivácia, a to pre polynomické a goniometrické funkcie. 
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Úlohou žiakov bolo nájsť súvislosť medzi lokálnymi extrémami funkcie a jej prvou aj druhou deriváciou. Objavené zákonitosti mali  overiť na ľubovoľnej ďalšej funkcii v programe Graphmatica [5]. Nájdenie súvisu medzi lokálnymi extrémami a prvou deriváciou nerobilo problémy. Ukázalo sa však, že nájdenie súvislosti s druhou deriváciou bolo ťažké, podarilo sa to len 6 žiakom. Takto voľne formulovaný problém bol pre žiakov zrejme ťažký, vhodnejšie by bolo ponúknuť žiakom nejaké hypotézy, ako sme to urobili pri vyšetrovaní monotónnosti.
6. Testy

Metódy: preverovanie vedomostí, samostatná práca žiakov na PC 
Použité zdroje: 
[11] - http://www.univie.ac.at/future.media/moe/tests/diff1/ablerkennen.html
[12] - http://www.univie.ac.at/future.media/moe/tests/diff1/poldiff.html
Popis: Internet ako bohatý zdroj materiálov je možné využiť aj vo fáze preverovania a hodnotenia vedomostí žiakov. Použili sme stránky Maths Online, kde môžeme nájsť interaktívne testy z matematiky rôzneho typu a z rôznych tematických celkov. Výhodou využitia takýchto interaktívnych testov je efektívnosť, okamžitá spätná väzba a vyhodnotenie, možnosť práce vlastným tempom. 

Na vyučovaní mali žiaci riešiť dva testy:
a) The big derivative puzzle [10] – tento test je označený ako puzzle, teda skladačka. Úlohou žiakov bolo správne priradiť graf derivácie funkcie ku grafu pôvodnej funkcie. Dobre tu mohli využiť vedomosti z predchádzajúcich vyučovacích hodín o súvise derivácie funkcie s monotónnosťou a lokálnymi extrémami.   

[image: image27.jpg]


 
Žiaci tejto triedy zvládli test výborne, úspešnosť bola 93,9% (riešilo 23 žiakov). Pri opätovnom spustení testu počítač vygeneruje iné funkcie (z viac než 50 možných), čo spolu so skutočnosťou, že žiak pracuje iba s grafmi funkcií, umožňuje tento test použiť aj na klasifikáciu. Ďalšie podobné priraďovacie aplety možno nájsť na adrese http://www.univie.ac.at/future.media/moe/galerie/diff1/diff1.html#ableitung.

b) Differentiating polynomials [11] – tento test je označený ako multiple choice test, teda pri každej úlohe si žiaci vyberajú jednu z ponúknutých možností. Cieľom je správne 
určiť deriváciu na základe jej predpisu. 
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Úspešnosť bola opäť vysoká – 94,1%. Chyby vznikali pri derivovaní zloženej funkcie (najmä ak sa to snažili urobiť spamäti) a pri posledných dvoch úlohách, kde zamenili pojem graf derivácie funkcie s grafom pôvodnej funkcie. Keďže v tomto teste musí žiak porozumieť zadaniu v cudzom jazyku (angličtine alebo nemčine) a navyše pri opätovnom spustení obsahuje stále tie isté úlohy, nie je vhodný na klasifikáciu žiakov.
Záver
Používanie nových informačno-komunikačných technológií patrí ku kultúrnym zručnostiam blízkej budúcnosti a preto sa ani škola nemôže od nich izolovať. Jedným z cieľov matematického vzdelávania musí byť aj vytváranie a rozvoj schopností riešiť praktické problémy reálneho života pomocou nových počítačových technológií.
Predkladaná práca je malým príspevkom k vytvoreniu potrebného prepojenia matematického vzdelávania na nové informačné technológie. V práci zámerne neuvádzame presné matematické formulácie jednotlivých definícií a viet, pretože tie je možné nájsť v literatúre, napr. [15].  Našim zámerom bolo na príklade jedného tematického celku  ukázať možnosti využitia Internetu pri vyučovaní matematiky na gymnáziu. Navrhnuté a zrealizované aktivity pritom pokrývali oblasť motivácie žiakov, sprístupňovania nového učiva, precvičovania, problémové metódy ako aj oblasť preverovania a hodnotenia žiakov. Pozitívne reakcie žiakov, ich aktívna práca na hodinách a dobré výsledky nás presviedčajú o tom, že sme sa vydali správnou cestou. Budeme veľmi radi, ak naše nápady a skúsenosti inšpirujú aj ďalších kolegov.
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